Mental Retardation Quality Management
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Key Terms

In-Progress — This term is used when a document (Incident Report, Area Office
Management Review, Restraint Manager Review, etc.) has been created but not
Finalized.

Submitted — This term refers to when the Initial (version of the) Report has been
completed (by clicking the “Submit” button) by the Filing Agency. The Filing
Agency still needs to complete the Final (version of the) Report of the Incident
within 7 business days, but may no longer make edits to the Initial Report as it is
read-only.

Finalized — This term is used when a document (Incident Report, Area Office
Management Review, Restraint Report, etc.) has been completed (by clicking the
“Finalize” button) and is now read-only. There can be no more edits to a
document once it is read-only. Only those with the appropriate role and scope
will have access to, or even see, the finalize button.

Closed - This term refers to when the process flow for reviewing an Event is
complete.
- Minor Incidents are closed when the Area Office Management
Review marks the incident report as approved and Finalized.
- Major Incidents are closed when the Regional Office Management
Review marks the incident report as approved and Finalized.
- Medication Occurrence Reports (MORSs) are closed when the
Regional MAP review marks the MOR as approved and Finalized at
the Regional Office Management Review level.
- Restraint Reports are closed when the Commissioner’s Review is
completed or 120 days has elapsed since the Area Office
Management Review marked the Restraint Report as approved.

Events - Events include Incident Reports, Medication Occurrence Reports,
Restraint Reports, and Optionally Reportable Events. Each event (incident,
MOR, restraint,) is assigned a unique Event ID (number) when it is created.

Managing Workload

Overview

In order to manage their workload, Service Coordinators should consider utilizing
the following:

- Alerts — Use alerts to be aware of actions occurring with events in your
scope that may require more immediate attention during the current
business day. Think of Alerts as news flashes, as they arrive within
moments after the Submit or Finalized button has been pressed.
However, it is not a good idea to manage the caseload thru Alerts, given
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that there are up to 7 business days to respond to a submitted event and
that each event can generate multiple alerts.

- Process Management Screens — These screens can be thought of as
your daily newspaper and are a better way to manage open events on the
caseload. There are two screens: Filing Process Management and the
Review Process Management. The former shows what the filing agency
(generally the provider) is responsible for taking action; the latter is what
the receiving agency (generally DMR) is responsible for taking action on.
These two screens are refreshed overnight meaning they contain the
latest data from previous days but do not reflect any changes made during
the current business day. Once an event has been closed, HCSIS will
automatically remove it from the screen the following business day. The
user may consider printing the screen (File > Print) daily (usually during
the first log-in of the day) rather than returning to it multiple times during
the day while working the HCSIS caseload.

- Reports — Offer an additional way to manage events occurring in scope.
For example, patterns of individual behavior can be charted through the
Events by Individual Detail report. Patterns of events occurring at provider
sites can be charted through the Events by Site/Provider report.

Process Management Screens
There are two. Navigate to them by clicking:

QM > IM > Filing Process Management
| Health an§l Human Services

#Entry | Restricted AcC

> Filing Process Management > Search

Review Process Mgt.

Criteria

From Date (MM/DD/YYYY): * [05/01/2005 To Date {(MM/DD/YYYY): * [05/19/2006
Area Dffice: | | Region: | |
Include: | | Sort By: | =

Search Reset

Event Name Event Primary Secondary Recent Person Provider Provider Site Area Office

D Date Nature Nature Mil p ible for
FollowUp
Medication
11 CREAMERY
BROWNLEE, Occurrence THE ASSOCIATION
187 PARALLEL 01/25/2006 MOR Wrong Dose Report - In FOR COMMUNITY . : Springfield/Westfield
BUCKLAND
progress
©2005 Commanwealth of Massachusetts Friday, May 19, 2006 212 PM Your session will end sometime after 4:12 PM
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JQM > |[M > Review Process Management

Health-sgd Human Services

Mass. /o =

| Review Process Mgt.

CCESS | REpOTE WEiling Process Mﬁ

> Review Process Management > Search

Event Search Criteria
To Date (MM/DD/Y¥YY): * [05/01/2006

From Date (MM/DD/YYYY): * [05/01/2005

Area Office: | | Region: | |
Include: | - Sort By: | -
Area Management Review Status: | -
Search Reset
Event Name Event Primary Secondary Recent Person Provider Provider Site  Area Office
D Date Nature Nature Mil: p ible for
Follow Up
Medication 201 HENDERSON
4 gimNLEEE’ 01/23/2006 MOR Wrong Route Occurrence —Frg: égaﬁ:ﬂ:}wr\l 5 Springfield/Westfield
Report - Finalized " CLARKSBURG

B©2005 Commonwealth of Massachusetts Friday, May 19, 2006 2:16 PM Your session will end sometime after 4116 PM

A Search can be performed by entering the From Date and the To Date (Note
date format) then clicking the Search button. The information contained on
these screens will inform the user of events that have been entered into HCSIS

within their scope.

Event Search Critoet
From Date (MM/DD/YYYY): * [b5/01/2005 To Date (MM/DD/YYYY): * )05/01/2006
Are 2| =l afl|

=
Include: Sort By: | =l
Area Management Review Status: |
Search Reset
Event Name Event Primary Secondary Recent Person Provider Provider Site  Area Office
h(n] Date Nature Nature Mil p ible for
Follow Up
Medication 201 HENDERSQON
145 Eig:ﬁ”éEE‘ 01/23/2006 MOR Wrong Route Occurrence Zgg égaﬂﬁjﬁ?\?N o Springfield/Westfield
Report - Finalized " CLARKSBURG
Friday, May 19, 2006 2:16 PM Your session will end sometime after 4:16 PM

©2005 Commeonwealth of Massachusetts

TIP: The Process Management Screens include a mechanism to jump to the
event’'s switchboard via the Event ID hyperlink. To open the Event in a new
browser window: Right Click > Open in New Window. This will allow the user
to toggle back and forth between the switchboard and the event.

Additional Information
- Filing Process Management - This screen allows the user to view an
event that is currently in process on at the Filing Agency, but not yet

5
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completed. The following event statuses are viewable for each event
under the Recent Milestone column:

Event Recent Description Next Steps
Type Milestone
Incident Initial Report - In | Incident Report that has been Filing Agency will
progress created but not Submitted or Submit the Initial Report
Finalized within 1 day for a major
incident or within 3 days
for a minor incident
Incident Initial Report — Incident Report that has the Initial | Filing Agency will
Submitted Report submitted, but the Final Finalize the Final Report
Report has not been Finalized within 7 days of Incident
Incident Incident Report - | Incident Report that has been Filing Agency will read
Not Approved Finalized but was marked as Not | Area/Regional Reviews,
Approved by the Area Office amend the Incident
Management Review and sent Report, and Finalize the
back to the Filing Agency for Final Report
more details
Medication Medication Medication Occurrence Report Filing Agency will
Occurrence | Occurrence that has been created but not Finalize the MOR
(MOR) Report - In Finalized
progress
Medication Medication Medication Occurrence Report Filing Agency will read
Occurrence | Occurrence that has been Finalized but the the MAP Coordinator
(MOR) Report - Not MAP Coordinator Review was Review and Finalize the
Approved marked Not Approved. The MOR
provider will need to re-finalize
the MOR.
Restraint Restraint Report - | Restraint Report has been Filing Agency will
In progress created but not Finalized or the Finalize the Restraint
Restraint Report has been Report and the
Finalized but the Restraint Restraint Manager
Manager (usually SC) Review has | Review
not been Finalized
Restraint Restraint Report - | Restraint Report that has been Filing Agency will read
Not Approved Finalized but was marked as the Area Management
Incomplete by the Area Office Review and Finalize the
Management Review and sent Restraint Report
back to the Filing Agency.

- Review Process Management - This screen allows the user to view what
has been processed by the Filing Agency (generally the provider) and is
now under DMR review. The following event statuses are viewable on this
screen under the Recent Milestone column:

Recent

Description

Next Steps

Incident

Milestone
Final Report —
Finalized

The Incident Report (Initial
Report/Final Report) has been
Finalized by the Filing Agency

Area Office
Management Review
needs to be created and
Finalized by the SC,
SCS, and Area Director
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Event Recent Description Next Steps
Type Milestone
/ Designee
Incident Area The Area Office Management Area Office
Management Review has been created and is Management Review
Review - In awaiting Finalization needs to be Finalized by
Progress the SCS for a minor
incident or the Area
Director/Designee for a
major incident
Incident Area The Area Office Management Regional Office
Management Review has been Finalized and Management Review
Review — marked the Incident Report as needs to be created and
Finalized Approved. A major incident Finalized by the
requires a Regional Office Regional Director /
Review. Designee
Medication Medication Medication Occurrence Report Region MAP Review
Occurrence | Occurrence has been Finalized by the Filing needs to be created and
(MOR) Report — Agency. Finalized by the
Finalized Regional MAP
Coordinator
Medication MAP Review - In | Regional MAP Review has been Regional MAP Review
Occurrence | progress created and is awaiting needs to be Finalized by
(MOR) Finalization the Regional MAP
Coordinator
Restraint Restraint Restraint Report and Restraint Area Office
Manager Review | Manager Review has been Management Review
— Finalized Finalized by the Filing Agency needs to be created &
Finalized by SC/SCS
Restraint Area The Area Office Management Area Office
Management Review has been created and is Management Review
Review - In awaiting Finalization needs to be Finalized by
progress the SC/SCS
Restraint Area The Area Office Management HR Committee Review
Management Review has been Finalized and is | and Commissioner’s
Review — awaiting the HR Committee Office Review (Optional)
Finalized Review / Commissioner’s Office need to be created and
Review before being closed out Finalized
Restraint Human Rights The Human Rights Committee HR Committee Review
Committee Review has been created and is needs to be Finalized
Review - In awaiting Finalization
progress
Restraint Human Rights The Human Rights Committee Commissioner’s Office
Committee Review has been Finalized Review needs to be
Review — completed or 120 days
Finalized needs to elapse to close
out the Restraint
Restraint Commissioner’s The Commissioner’'s Review has | The Commissioner’s
Review — In been created and is awaiting Office Review needs to
progress Finalization be Finalized to close out
the Restraint
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Alerts

Alerts in HCSIS can be accessed two ways:

1. The Alerts link on the homepage (upper left hand corner — click on the
underlined word next to the yellow triangle)

Health and Human Services Mass. jov - =
i =71 |
A siras Mental Retardation Quality Management Reporting (HCSIS)]

This application is designed to be the primary quality management and health care
reporting system for the Department of Mental Retardation. This system can capture

2.Tools > Alerts > Pending Alerts

Health and Human Services Mass.iovii=" —
4 —aall
oM ! Zumin | TooLs
RePorts | Alerts | Misc M-ATEilities | DPPC
‘ Pending Alerts
Tools s—AtaTTs > Pending Alerts > Pending Alerts
Alert Search Criteria
Subject: | | Recipient User: -

Reset Search

Your search found multiple matches. Please select the desired Alert.

Page 1 of 2 Go To : |Page 1 = ﬂl
Select Date of Alert Alert Subject Alert Message

An Incident has been closed: Individual Name: BROWNLEE, PARALLEL; Event ID:
988; Primary Nature: Unexpected Hospital Visit; Secondary Nature: Psychiatric
Hospitalization; Incident Date: 05/19/2006; Incident Time: 09:00 AM; Human
Services Coordinator Name: BROWNLEE, BOB.

Oversight entities are alerted an Incident Report for a Minor Incident has been
Finalized: Individual Name: BROWNLEE, PARALLEL; Event ID: 988; Primary

r 05/19/2006 |Minor Incident has been Finalized Nature: Unexpected Hospital Visit; Secondary Nature: Psychiatric
Hospitalization; Incident Date: 05/19/2006; Incident Time: 09:00 AM; Human
Services Coordinator Name: BROWNLEE, BOB.

Oversight entities are alerted an Incident Report for a Major Incident has been
Einalized: Individual Name: BROWNLEE, PARALLEL; Event ID: 961; Primary

r 05/19/2006 |Major Incident has been Finalized Nature: Unexpected Hospital Visit; Secondary Nature: Psychiatric
Hospitalization; Incident Date: 05/19/2006; Incident Time: 11:00 AM; Human
Services Coordinator Name: BROWNLEE, BOB.

r 05/19/2006 An Incident has been closed

Note: After checking the Process Management screens in the morning the user
should periodically check their alerts to be informed of anything that has
happened current business day, and which may require immediate attention.

TIP: The Alerts Screens also provides a mechanism for the user to quickly
navigate to the event’'s switchboard via the Alert Subject hyperlink. To open the
alert in a new browser window: Right Click > Open in New Window.
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Helpful Alert Hints:

1. The most recent alert will appear at the top of the screen
2. Multiple alerts can be sent for the same event. To keep the alert screen

clean, delete old alerts

3. Use the Alert Search Criteria by Subject drop down menu to filter out a

particular alert

4. Use the Alert Search Criteria by Recipient drop down menu to filter out a

particular user’s alerts

Reports

Reports can be accessed by Tools > Reports > Reports Request

This will display a list of reports available to your HCSIS role. The Reports are
useful, other than for statistical purposes, for, e.g., determining patterns of
behavior of individuals and also for the staff with which they are involved. To run
a chosen report, for example, Events by Site/Provider, enter required fields, and
click View Report. There are three choices through which to view a report:
Adobe Acrobat, Rich Text or Plain Text. Most users may wish to use Rich Text.

i)
COMMONWEALTH OF MASSACHUSETTS Fun Date Cf-;f- ‘;fcs
DEPARTMENT OF MENTAL RETARDATION AT e e anne 4.37.4
[NCIDEMT MANAGEMENT - EVENTS BY SITE/PROVIDER REPORT As Of Date a5 fEspm
Begin Date (MM /DD /YYYY): 01/01/2006
End Date (MM/DD/YYYY): 08/ 14/2006 v
SSM #: NULL
First Mame: NULL . H
ety Note: when run times and
Primary Mature: MULL
Secondary Nature: NULL dates are the same, the
Provider: NULL t . t th . t
Site: MULL
Ste:NULL report is up to the minute.
B L Some reports refresh
Event Category: NULL
Area/Provider Reported Incidents: MULL
Provider : THE ASSOCIATION FOR COMMUNITY LVING
Site ; 1 CARANDO DR, SPRINGFIELD, M
Individual's Mame : BROWMLEE, PARALLEL
Event Event Date Event Day of Filing Agency Primary Nature Secondary Person Status
1D Time Week Natwre ]flesmlrllsmle
or Follow-up
514 05/17/2006 12:00 pm Wednesda THE &550CIATION Physical Altercation Individual to Open
FOR COMMUMITY Individual, &lleged
LVING Perpetrator
1328 05/13/2006 12:00 am Saturday  THE 4550CIATION  (ther Other MEAL, REBECCA  Clased
FOR COMMUMITY
LVING
1335 05/13/20068  9:30 am Saturday THE A55CCIATION Physical Altercation Individual to BARE, AL Clased
FOR. COMMUNITY Individual, 2leged
LVING vidim

| Commonwealth of Massachusetts - Department of Mental Retardation

9
updated 02.16.2007



	 Key Terms
	Managing Workload
	Overview
	Process Management Screens

	Additional Information
	Alerts
	Reports


